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1. Introduction to Kernel for Outlook Express to
Notes

Welcome to the user manual of Kernel for Outlook Express to Notes, an email migration software for
Outlook Express users. The software helps in migrating emails and other items of Outlook Express (.DBX)
to Lotus Notes (.NSF). This user manual comprises step by step guidelines on using Kernel for Outlook
Express to Notes.

1.1 Using this Manual

This user manual is intended to guide users on using Kernel for Outlook Express to Notes. We suggest
that first time users should read this user manual completely and carefully before proceeding to use the
software. However, if you are an experienced user, you can use the table of contents to find out
information pertaining to the tasks that you need to perform by using Kernel for Outlook Express to Notes.
You can use the table of contents to navigate through different sections of this user manual. The table of
contents lists all the sections that are contained in this user manual in chronological order. The user
manual comprises the following sections:

e Introduction

o Getting Started

e Software Interface

e Converting Outlook Express Items to Notes

e Full Version

e Support

e Troubleshooting

e Legal Notices

Certain abbreviations have been used throughout this manual. For clear understanding of the contents of
this user manual, please go through the list of abbreviations, mentioned below, before reading the manual.

1.1.1 List of Abbreviations

DBX: File extension for Outlook Express files
NSF: Notes System File
OE: Outlook Express

MS: Microsoft
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RAM: Random Access Memory

MB: Mega-Byte

GB: Giga-Byte

1.2 About Kernel for Outlook Express to Notes

Kernel for Outlook Express to Notes is an email migration tool which effectively moves emails,
attachments, images, text in Outlook Express environment to Lotus Notes (.NSF) environment. Kernel for
DBX to NSF uses powerful migration algorithm that converts .DBX files to .NSF files. The converted files
are easily accessible with Lotus Notes email client.

Emails, message properties, attachments, embedded images, email data, Unicode characters, sent items,
drafts, outbox, emails which exist in deleted items folder, and items which are saved in personal folders
are effectively migrated from DBX file to NSF file with Kernel for Outlook Express to Notes.

1.3 Salient Features

Salient features of Kernel for Outlook Express to Notes include:

o Efficient embedded migration algorithms to quickly export files from OE to Notes environment
o [Easyto use, User friendly features with attractive interface

e Supports Unicode character migration

e Supports migration of as many .DBX files

o Displays preview of email data before saving the DBX file items

e Supports every version of Lotus Notes and Outlook Express for migration

e Converted .NSF files are easy to be mounted in Lotus Domino Server

e Two saving options: Single .NSF file saving and Multiple .NSF file saving

o Free evaluation version available which lets you save first 10 emails from the listed .DBX files

1.4 Who Should Use this Software?

Kernel for Outlook Express to Notes is an ideal tool for system administrators, individuals, technicians who
need to migrate from Outlook Express to Lotus Notes email client. Its user friendly interface makes it easy
to access requiring no special technical skills at all. All the .DBX files get converted to .NSF files within
minutes with all the attachments, if any.
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2. Getting Started

Now that you have understood the features and potential of Kernel for Outlook Express to Notes, you are
ready to get a hand on experience of the software. To start the process of migration, you will first need to
download and install this software.

It is strongly recommended that before installing Kernel for Outlook Express to Notes, you should go
through the installation pre-requisites for the software to ensure that your computer is appropriately
configured to run the software.

2.1 Installation Pre-requisites

The various pre-requisites for installing and running Kernel for Outlook Express to Notes can be broadly
classified into two major categories — Hardware requirements and Software requirements.

2.1.1 Hardware Requirements:

The hardware requirements for installing the software are as follows:
e Pentium Class Processor
e Minimum 64MB RAM (128 MB recommended)
e 10MB for Software installation

e Disk Space - Enough space to save the results

3. You should have at-least 10 MB of free disk space if you want to migrate and save a
10 MB.DBX file.

2.1.2 Software Requirements:

The software requirements for installing the software can further be grouped into two categories —
Operating System requirements and Outlook Express, Lotus Notes version requirements.

The requirements are as follows:

2.1.2.1 Operating System Requirements
Supported operating systems:

e Windows Vista

e Windows XP

e Windows 2003

e Windows 2000
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2.1.2.2 Outlook Express Version Requirements
Supported Outlook Express versions:

e Version4.0,5.0,5.5,6.0
2.1.2.3 Lotus Notes Version Requirements
Supported Lotus Notes versions:

e Version 6.5, 7.0, 8.0

W Outlook Express and Lotus Notes should be installed on the computer system on
which you are performing the migration.

2.2 Downloading Kernel for Outlook Express to Notes for the First
Time

After checking your computer with the prescribed system requirements for Kernel for Outlook Express to
Notes, you can download and install the software on your computer. You can buy the full version of the
software from any one of our authorized resellers — Element5, Asknet and 2CO.

If you want to try using Kernel for Outlook Express to Notes before buying it, you can download the
evaluation version from the following link:

http://www.nucleustechnologies.com/download-dbx-to-nsf-conversion.php

A You can save first 10 email items from every existing folder in the .dbx file. In order
to save the entire converted email items of Outlook Express, you must purchase the
full version of the software.

2.3 Install Kernel for Outlook Express to Notes

After downloading the installer file for Kernel for Outlook Express to Notes, you can install the software by
running the file. To install Kernel for Outlook Express to Notes:

1. Double-click the Kernel for Outlook Express to Notes installer. Follow the on-screen instructions.
The Setup Installation Complete screen will be displayed.

2. Click Finish to launch the software.

2.4 Start Kernel for Outlook Express to Notes

To start Kernel for Outlook Express to Notes:

Click the Start = All Programs >Kernel for Outlook Express to Notes

Kernel 51;5
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Alternatively, you can launch Kernel for Outlook Express to Notes by double-clicking the shortcut icon
available on the Desktop and Quick Launch icon.

2.5 Uninstall Kernel for Outlook Express to Notes

You may need to uninstall Kernel for Outlook Express to Notes. To uninstall the software:

1. Click the Start - All Programs —>Kernel for Outlook Express to Notes - Uninstall Kernel for
Outlook Express to Notes

A warning message will be displayed.

2. Click ‘Yes’ to uninstall Kernel for Outlook Express to Notes.

X Before proceeding to uninstall Kernel for Outlook Express to Notes, you must ensure
that the software is not running.

You can alternatively uninstall Kernel for Outlook Express to Notes from the Control Panel by performing
the following steps:

1. Click the Start Menu - Control Panel and then double click the Add or Remove Programs icon.
2. Select Kernel for Outlook Express to Notes and click Remove.
A warning message will be displayed.

3. Click ‘Yes’ to uninstall Kernel for Outlook Express to Notes.
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3. Software Interface

Now that Kernel for Outlook Express to Notes has been installed on your computer, you can start using
the software after getting acquainted with the software interface.

3.1 Menu-bar

The menu-bar of Kernel for Outlook Express to Notes comprises two main menus — File and Help.

3.1.1 File Menu

The File menu comprises three menu items.

Ctrl+ O
Ctrl+5

Figure 3.1: File Menu

Menu items in the File menu:

Open Select to browse and add .DBX file to Kernel software for
migration

Save Select to view the saving options for saving the converted .DBX
file items

Exit Select to exit from the software

3.1.2 Help Menu

The Help menu comprises one menu item.

Help
About Kernel for Qutlook Express to Motes

T r L | |

Figure 3.2: Help Menu

Menu item in the Help menu:
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About Kernel for Outlook Select to view version information, support details for
Express to Notes Kernel for Outlook Express to Notes software
3.2 Tool-bar

The tool-bar in Kernel for Outlook Express to Notes is displayed below the menu-bar. The tool-bar
provides a convenient and user-friendly method to perform certain actions that can also be performed by
using the menu-bar. Read the information in the table below to find out about the tool-bar buttons:

i Open Click to browse and add .dbx file to Kernel
\) software for migration
Tpen
I Save Click to view the saving options to save the
converted .dbx file items to .nsf file
Save
Help Click to view User's Guide of Kernel for Outlook
9 Express to Notes software
Help

< [ "n cos)
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4. Converting Outlook Express Items to Notes

Now that you have complete familiarity of the user interface of Kernel for Outlook Express to Notes, you
are ready to migrate .dbx files to .nsf files. To perform migration:

1. Launch Kernel for Outlook Express to Notes.

2. Open window pops-up as soon the software is launched. .DBX files can be browsed and selected for
migration with this window.

™ The default user profile configured in Outlook Express email client is listed by the
Kernel software. Every folder which exists in the default configured profile of Outlook
Express gets listed in the Kernel software to view preview of the file contents.

File Help
N (2
Open Save Help
Folder List

= [0~ Outhook Express
[#]. 5} Deleted Items

[¥]. Drafts

& [#]L] Inbox
[¥]i=) Outbox
[¥]L5) Sent Items
[#]i5) test

(QECI(=)ZC) <o
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Migrate from Outlook Express to Lotus Hotes

Please select Dbx file from toolbar or file menu

! [ Feom

Subgect

D ate/Time

Look i | < Local Disk (C:]

O & @

JMSOCache
INSF
Jjautlook express
|_)Programil
\__)Program Files
L2 WINDOWS

File name:

3] User1-DEX .dbx

< R

b

Figure 4.1: Select DBX file
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3. Selected .DBX file get listed in the software. Select the file to view its contents.
Kernel software will now start scanning and extracting the selected .DBX file contents.

4. After successful extraction of the DBX file items, those items will be displayed in a tree like structure.

W The converted attachments can only be opened or accessed in saved .NSF file
opened with Lotus Notes email client. Kernel software will only display the
attachment icon which assures that the attachment(s) are successfully converted by
the software.

K] Kernel for Qutlook Express to Motes - Version 8.10.01 =
File Wiew Help

tg 9 jl‘vij_;i- Kernel for Outlook Express to Notes
Help LJ p Migrate from Outlook Express to Lotus Hotes

Folder List Please select Dbx file from toolbar or file menu

B[l outlook Express ! O Fram Subject L ate/ Time
VL5 A.Pending
[Vl Deleted Ttems
[Vl Drafts
[Vl Inbox
. _] Outbox

nnnnnnnnnn

.;v ol 'Ldbx filest Inbosx, dbs

Fram

To: To

Figure 4.2: Selected DBX file
5. Select the folder or profile which you want to save and click the Save button from toolbar.
Kernel software provides two saving options: Save in single NSF file and Save in multiple NSF files.

e Save in single NSF file: This option lets you save file contents of several DBX files into one NSF
file. The converted items get listed in the Lotus Notes profile according to their profiles, with which
you can view the converted items.

e Save in multiple NSF files: This option lets you save file contents of separate DBX files into
separate NSF files. The converted items of each individual file gets transferred to individual NSF
files which are then accessed with Lotus Notes email client.
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e Save item content in text format: Enable this option if you want to save the DBX file items
without preserving the email data formatting. This will speed up the saving process of heavy sized
DBX files.

4.1 Save in Single .NSF file

The Save in Single .NSF file saving option enables you to save email items of several .DBX files into one
.NSF file.

e Select Save in single NSF file radio button and click OK.

Saving option r'5_(|

Select zaving option

(%) Save in zingle M5F file
() Save in multiple Msf files

[15awve itern content in text format

[ (n] 4 q [ Cancel

Figure 4.3: Save in Single NSF File

e A window will appear and asks for NSF file saving path, whether you want to save in new file or
save in existing file. Choose accordingly and click OK.

Save Options ['5_<|
Fleaze provide MSF file detailz

(=) Save in Mew file

MSF Folder Path | [rhoe-to-nokes-14-ock | E]

MSF File Mare : |L|ser'| |

() Save in existing file

MSF File Mame : | |

[] 5ave item content in bext format

2k, ] [ Cancel

Figure 4.4: Save Option

As soon the saving gets completed, a message box will appear confirming the saving process. Kernel
software will start the saving process.

Kernel :;@

©Nucleus Data Recovery.Com Private Limited 0ax o NSF



4.2 Save in Multiple .NSF Files

The Save in Multiple .NSF files saving option is best when you have many .DBX file(s) and want to save
the converted items in individual .NSF file(s). Kernel software allows you to save multiple .DBX file(s) into
multiple .NSF file(s). For example, if you want to convert 4 .DBX files and want to view them in separate
.NSF file(s), then select the Save in Multiple .NSF files option, Kernel software will then create 4 different

.NSF files at the defined save location.

e Select the Save in multiple NSF files radio button and click OK.

Saving option

Select zaving optian

() Save in single MSF file

(%15 ave in multiple M5F files

[ 15ave item content in text format

[ OF. l [ Cancel

X

Figure 4.5: Save in Multiple NSF Files

e The Browse for Folder window gets opened. Select the folder where you want to save the
converted .dbx files to multiple .nsf file(s) and click OK button to continue.

Browse For Folder

Select Caching MailBox Path

?IX

My Docurments

o®

HEEE BT

M Cormpuker

5 315 Floppy (A

e Local Disk (C:)

e Software (D0

@ design (E:)

e Pew Yolume (F:)
i CD Drive (&)

=]

Falder: | My Docunments

[ Make Mew Folder ] [ K l [ Cancel

]

Figure 4.6: Browse for Folder
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Kernel software will start the saving process. As soon the saving gets completed, a message box will
appear confirming the saving process. The saved .NSF files can be viewed and accessed from the saved
location with Lotus Notes email client.

. When the saved .NSF file is opened with Lotus Notes, the selected .DBX file gets
listed under the “Folders” folder in Lotus Notes.
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5. Full Version

Although you can use Kernel for Outlook Express to Notes evaluation version for free and experience the
capabilities of the software, there are certain features that are not available in the evaluation version.

5.1 Requirement of Full Version

By using the evaluation version of Kernel for Outlook Express to Notes, you can perform the migration
from Outlook Express environment to Lotus Notes environment and can save the first 10 email items per
folder existing in the .DBX file. You cannot save the entire converted data in .NSF format.

You must purchase Kernel for Outlook Express to Notes software in order to save the entire converted
email items of Outlook Express.

5.2 Purchasing Full Version

You can buy the full version of Kernel for Outlook Express to Notes from any one of our authorized
resellers — Element5, Asknet and 2CO.

As soon as the purchase transaction with our resellers gets completed, our sales team will send you an
email comprising the URL to download the full version of Kernel for Outlook Express to Notes and
activation details of the software.
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6. Support

We have an extensive and efficient support system in place to assist our customers with all issues related
to using Kernel for Outlook Express to Notes. The software comes with an embedded help manual that
can be accessed by clicking Help-> Help in the tool-bar. You can also press the F1 key on the keyboard
of your computer to access the embedded help of Kernel for Outlook Express to Notes.

You can access the online help for Kernel for Outlook Express to Notes at
http://www.nucleustechnologies.com/Online-Helps.html

View Animated Working demo of the software at
http://www.nucleustechnologies.com/Animated Demo DBX to NSF.html

We also have live support wherein you can chat with our software experts at
http://www.nucleustechnologies.com/Support.html

To talk on phone with our software experts call:

Help line:

+91-9818725861
1-866-348-7872 (Toll Free for USA/CANADA)
You can also email us about your queries at;

sales@nucleustechnologies.com for Sales

support@nucleustechnologies.com for Support

contact@nucleustechnologies.com for General Queries
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/. Troubleshooting

This section deals with your generic and specific queries pertaining to using Kernel for Outlook Express to
Notes.

7.1 Common Issues

Why does Kernel for Outlook Express to Notes have limitations in evaluation copy?

The free evaluation version of Kernel for Outlook Express to Notes is intended to enable you to experience
the capabilities of the software. You will need to buy the software to save the entire converted email items
in .NSF file.

7.2 Frequently Asked Questions

How to Buy Kernel for Outlook Express to Notes?

You can buy Kernel for Outlook Express to Notes online at http://www.nucleustechnologies.com/buy-dbx-
to-nsf-conversion.php

I have lost my full version for Kernel for Outlook Express to Notes. Can you help me?

Please email us at sales@nucleustechnologies.com. Please include your name, address, email address,
and order confirmation number (if you have it). We will be happy to help you.
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8. Legal Notices

This section comprises the legal specification about Kernel for Outlook Express to Notes and the company
NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED

8.1 Copyright

NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED, Nucleus Kernel accompanied user manual and
documentation are copyright of NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED, with all rights
reserved. Under the copyright laws, this user manual cannot be reproduced in any form without the prior
written permission of NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED. No Patent Liability is
assumed, however, with respect to the use of the information contained herein.

© NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED. All rights reserved.
8.2 Trademark

Nucleus Kernel ® is a copyright work of NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED

Windows 95®, Windows 98®, Windows ME®, Windows NT®, Windows 2000 Server®, Windows 2000
Advanced Server®, Windows 2003 Server®, Windows XP®, Windows Vista, MS-DOS, Outlook Express
and Lotus Notes are registered trademarks of Microsoft Corporation and IBM.

All other brand and product names are trademarks or registered trademarks of their respective companies.

8.3 Disclaimer

The Information contained in this manual, including but not limited to any product specifications, is subject
to change without notice. NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED provides no warranty
with regard to this manual or any other information contained herein and here by expressly disclaims any
implied warranties of merchantability or fithess for any particular purpose with regard to any of the
foregoing NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED assumes no liability for any damages
incurred directly or indirectly from any technical or typographical errors or omissions contained herein or
for discrepancies between the product and the manual. In no event shall NUCLEUS DATA
RECOVERY.COM PRIVATE LIMITED, be liable for any incidental, consequential special, or exemplary
damages, whether based on tort, contract or otherwise, arising out of or in connection with this manual or
any other information contained herein or the use there of.

8.4 License Agreement

Kernel for Outlook Express to Notes software is Copyright work of Nucleus Data Recovery.Com Private
Limited

Your Agreement to this License

You should carefully read the following terms and conditions before using, installing or distributing this
software, unless you have a different license agreement signed by NUCLEUS DATA RECOVERY.COM
PRIVATE LIMITED. The terms and conditions of this License describe the permitted use and users of
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each Licensed Copy of Kernel for Outlook Express to Notes software. For purposes of this License, if you
have a valid license, you have the right to use a single Licensed Copy of Nucleus Kernel.

Scope of License

Each Licensed Copy of Kernel for Outlook Express to Notes software may either be used by a single
person or used non-simultaneously by multiple people who use the software personally installed on a
single workstation. All rights of any kind in Nucleus Kernel, which are not expressly granted in this
License, are entirely and exclusively reserved to and by NUCLEUS DATA RECOVERY.COM PRIVATE
LIMITED. You may not rent, lease, modify, translate, reverse engineer, decompile, disassemble, or create
derivative works based on, Nucleus Kernel, nor permit anyone else to do so. You may not make access to
Nucleus Kernel available to others in connection with a service bureau, application service provider, or
similar business, nor permit anyone else to do so.

Warranty Disclaimers and Liability Limitations

Kernel for Outlook Express to Notes software, and any and all accompanying software, files, data and
materials, are distributed and provided AS IS and with no warranties of any kind, whether expressed or
implied. In particular, there is no warranty for the quality of data recovered. You acknowledge that good
data processing procedure dictates that any program, including Nucleus Kernel, must be thoroughly tested
with non-critical data before there is any reliance on it, and you hereby assume the entire risk of all use of
the copies of Nucleus Kernel covered by this License. This disclaimer of warranty constitutes an essential
part of this License. In addition, in no event does NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED
authorize you or anyone else to use Kernel for Outlook Express to Notes software in applications or
systems where Kernel for Outlook Express to Notes software failure to perform can reasonably be
expected to result in a significant physical injury, or in loss of life. Any such use is entirely at your own risk,
and you agree to hold NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED harmless from any and all
claims or losses relating to such unauthorized use.

General

This License is the complete statement of the agreement between the parties on the subject matter, and
merges and supersedes all other or prior understandings, purchase orders, agreements and
arrangements. This License shall be governed by the laws of the State of Delhi. Exclusive jurisdiction and
venue for all matters relating to this License shall be in courts and for a located in the State of Delhi, and
you consent to such jurisdiction and venue. There are no third party beneficiaries of any promises,
obligations or representations made by NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED herein.
Any waiver by NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED of any violation of this License by
you shall not constitute, nor contribute to, a waiver by NUCLEUS DATA RECOVERY.COM PRIVATE
LIMITED of any other or future violation of the same provision, or any other provision, of this License.
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